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Question 1:

View this Question Online =

Look at the image MS Word 2016 and identify which tab all the elements present in the given image
fall under?

Calibri (Body) '

LY

14 | A Al Aa - e
Paste B I U~ abe X, X v v
v * Format Painter o 2 A L

Clipboard ] Fant ]

1. Insert

]

Answer (Detailed Solution Below)

Option 2 : Home
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Microsoft Word Question 1 Detailed Solution

The correct answer is Home Tab

€2 Key Points

Home is the one that contains commonly used formatting options like font style, size, and
alignment.
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Question 2:

VAT .' M ectioyrn Cinlime

The given image which list style present?
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* |[he standard Lorem Ipsum passage, used since tne 15005

‘- Section 1.10.32 of "de Finibus Bonorum et Malorum”, written by Cicero
in 45 BC

¢ 1914 translation by H. Rackham

1. Number List
2. Multilevel List
3. Bullets List

4, none of the above

Answer (Detailed Solution Below)

Option 3 : Bullets List

Microsoft Word Question 2 Detailed Solution

The correct answer is Eullets&

2 Key Points

« In the provided image, each item in the list is preceded by a small black dot, which is known as
a bullet point.

« This type of formatting is characteristic of a Bullets List. Unlike Number Lists or Multilevel Lists,

Bullets Lists use simple symbols (such as dots) to denote each item without any hierarchical
numbering or sub-levels. Therefore, the correct answer is 3) Bullets List.
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Question 3:

View this Question Online >
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How many Drop Cap in given document.

SETTEITUL ATHINE WUTTITTHENTL MEdaer rouuer I"Hg'i: =R L IR
- Videos El-_:l Cross-reference v ~  MNumber~ Box ~ Parts
Media Links Comments Header & Footer
[ = IEI 12 14 | 6o L8 i 110 112 114 LA 118

Ipgum has beesn the industry's standard dumimiy texl ever since the 150s, when an

unknovwn printer ook a gaBey of type and scrambled it to make a [ype specirmen book,
| has survived not only Mee centiries, but alsa the [Eap intd electranic Bypedetting,

remaining essentially unchanged.

I orem lpsurm is simply dummy text of the printing and typesetting industry. Larem

Ipsurn passages, and rore recently with deskitop publishing software like Aldus

I 1 was popularided in the 19605 with the release of Letraset sheets containing Lorem
PageMaker including versions of Lorem lpsam.

1. 1
3. 2
3. 3
4. 4

Answer (Detailed Solution Below)

Option 2: 2

Microsoft Word Question 3 Detailed Solution

The correct answer is 2 ‘

&) Key Points

In the provided image, there are two large, capitalized letters at the beginning of two different
paragraphs, which are Drop Caps. These are:

« The letter "L" at the beginning of the first paragraph.
« The letter "I" at the beginning of the second paragraph.

Each Drop Cap spans multiple lines of text, which is a characteristic feature of Drop Caps. Therefore,
the correct answer is 2).

f*-é'

India's #1 Learning Platform
Start Complete Exam Preparation

& Trusted by 1,86,00,449+ Students



https://link.testbook.com/XVertTSUigb
https://testbook.com/objective-questions/mcq-on-microsoft-word--5eea6a1639140f30f369f54b

Daily Live | ] Practice Mock Tests
MasterClasses , Question Bank & Quizzes

P Download App

Question 4:

Match the following:

MS Word 365 Dptinn| Meaning
lcon

TE I. Symbol

A
b ¥ -
A Il. Equation

B.
c D ll. Page color
o, Q V. Watermark

1. A-LB-1L,C-1l,D-IV

2. A-ILB-ILC-IV,D-1

3. A-LB-LC-I,D -1V

4, A-IIkB-1,C-IV,D-1

Answer (Detailed Solution Below)

Option2:A-I1,B-II,C-1V,D-1

Microsoft Word Question 4 Detailed Solution

The correct answeris A-Il,B-1ll,C-1V,D -1


https://link.testbook.com/XVertTSUigb

) Key Points ‘

« A - Equation (II):
= Explanation: The pi (m) icon represents the "Equaticn” tool, used to insert mathematical
equations into the document.
« B - Page color (l1):
= Explanation: The paint bucket icon represents the "Page color” tool, used to change the
background color of the document pages.
« C - Watermark (IV):
= Explanation: The diagonal text icon represents the "Watermark” tool, used to add a faint
background text or image behind the document content.
« D - Symbol (I):
= Explanation: The omega (C2) icon represents the "Symbol” tool, used to insert special
characters and symbols into the document.
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Question 5:

View this Question Online =

Identify which of the following statements are true or false:

i) MSA
USETS.

365 allows you to create and edit documents collaboratively in real-time with other

i) The *AutoCorrect’ feature in MS-Word 365 automatically corrects common spelling and typing
errors.

1. i- False, ii - True

2. i-True, ii - True

3. 1- True, ii - False


https://testbook.com/objective-questions/mcq-on-microsoft-word--5eea6a1639140f30f369f54b

. 1= False, 1l - Fdise

Answer (Detailed Solution Below)

Option 2 : i - True, ii - True

Microsoft Word Question 5 Detailed Solution

The correct answer is i - Trua',‘ue

) Key Points

« Statement i: This is true. MS-Word 365 allows collaborative editing, meaning multiple users can
work on the same document in real-time.

« Statement ii: This is true. The "AutoCorrect’ feature in MS-Word 365 automatically corrects
commeoen spelling and typing errors as you type.

So, the statements are: i - True ii - True

Top Microsoft Word MCQ Objective Questions

@?5"
India's #1 Learning Platform
Start Complete Exam Preparation

8 Trusted by 1,86,00,449+ Students

1ﬂ Daily Live ,E] Practice [ , | Mock Tests
e 1=

MasterClasses g & Quizzes

B Download App

Question Bank

Question 6 W il
Which of the following is the shortcut key to open a 'New Blank' document in MS-Word?

1. CTRL + B
2. CTRL+ N
3. CTRL+ D

4. CTRL +M

A \
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Answer (Detailed Solution Below)

Option 2: CTRL + N

Microsoft Word Question 6 Detailed Solution

The correct answer is CTRL + N.

€. Key Points

« Create a new document with Ctri+N.

- Basic computer shortcut keys
= Ctrl + M -- Indent the paragraph.
> Ctrl + B -- Bold highlighted selection.
- Ctrl + D -- Font options.
= Alt + F--File menu options in the current pregram.
= Alt + E--Edits options in the current program.
= F1--Universal help (for any sort of program).
= Ctrl + A--Selects all text.
= Ctrl + X--Cuts the selected item.
= Ctrl + Del--Cut selecied
= Ctrl + C--Copy the select
Ctrl + Ins-- Copy the selectad item.
= Ctrl + V--Paste the selected item.
- Shift + Ins -- Paste the selected item.
Home -- Takes the user to the beginning of the current line.
= Ctrl + Home--Go to the beginning of the document.
End -- Go to the end of the current line.
Ctrl + End -- Go to the end of a document.
Shift + Home -- Highlight from the current position to the beginning of the line.
Shift + End -- Highlight from the current position to the end of the line.
= Ctrl + (Left arrow) -- Move one word to the left at a time.
= Ctrl + (Right arrow) -- Move one word to the right at a time.
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Guestion 7

feature of MS Word helps to create a list in a document.

1. Word Art
2. Scaling
3. Bullets and Numbering

4. Word Wrap

)\

Answer (Detailed Solution Below)

Option 3 : Bullets and Numbering

Microsoft Word Question 7 Detailed Solution

The correct answer is Bullets and Numbering.

View thi

« Bullets and Numbering feature of MS Word help to create a list in a document.

2 Key Points

« Bullets and Numbering are used to create a list in documents in MS word.
+ To create a list in MS Word:

= Select the text required to format as a list.

= Click on the Bullets or Numbering drop-down option on the Home tab.
= Select the bullet or numbering style required, and it will appear in the document.
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& Additional Information

- Word wrap is a word processing feature that automatically transfers a word that has
no insufficient space from the end of one line of text to the beginning of the next.

« Scaling in MS Word is another text effect to make the text larger or smaller.

« WordArt is used to create decorative effects to the text styles
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Question Bank

Question 8 View this C
In MS Word, "Ctrl + Home" is used to

1. Moves the cursor to the beginning of Document

2. Moves the cursor to the beginning of Line
3. Moves the cursor to the beginning of Paragraph

4, All of the above

Answer (Detailed Solution Below)

Option 1 : Moves the cursor to the beginning of Document

Microsoft Word Question 8 Detailed Solution

The correct answer is Moves the cursor to the beginning of the document.

» Ctrl + Home is a shortcut key used in MS Word to move the cursor to the beginning of the



QOCUurment.

£ Additional Information

Shortcuts in MS Word

Open a document. [Ctrl+0O

Create a new

document. Ctrl+N

Save the document.[Ctrl+5

Close the

document. Ctri-w
ICut the selected

content to the Ctrl+ X
Clipboard.

Copy the selected

content to the Ctrl+C
Clipboard.

Paste the contents eV

of the Clipboard.

Select all document i A
content.

Apply bold

formatting to the [Ctrl+B
text.

Apply italic

formatting to text. St
Apply underline
formatting to text. FamE
Qecrease th? font Ctrl+[
size by 1 point.
Irl1crea5ethe.font Ctrl+]
size by 1 point.

ICentre the text. Ctrl+E



https://link.testbook.com/XVertTSUigb

Align the text to the

left Ctrl+L

Align the text to the

right. Ctrl+R

ICancel a command. [Esc

Undo the previous

g Ctrl+7
action.

Redo the previous

action, if possible. X

Alt+W, Q, then tab in Zoom
dialogue box to the value
you want.

Adjust the zoom
magnification.

Split the document

: Ctrl+ Alt+5

window.

fismows the Alt+Shift+C or Ctrl+Alt+S
ocument window

split.
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Sunason § View this Question Online >
Which of the following shortcuts is used to select a sentence in a paragraph in MS-Word?

1. Alt + click on a sentence to select it

2. Single-click on a sentence to select it


https://testbook.com/question-answer/which-of-the-following-shortcuts-is-used-to-select--600e7c0a56d01623ebe3b19d
https://testbook.com/question-answer/which-of-the-following-shortcuts-is-used-to-select--600e7c0a56d01623ebe3b19d

3. Ctrl + click en a sentence to select it

4. Double-click on a sentence to select it

Answer (Detailed Solution Below)

Option 3 : Ctrl + click on a sentence to select it

Microsoft Word Question 9 Detailed Solution

The correct answer is Ctrl + click on a sentence to select it.

« Triple-click (Ctrl + click) on a sentence to select it is used to select a sentence in a paragraph
in MS Word.

A\ Mistake Points

» Double click can only select a single word but Ctrl+Click on a statement can select complete
statement. Hence option 3 is correct and 4 is incorrect.

€0 Key Points

Shortcut in MS word for selection:

« To select the current word, double-click on it.
« To select the current par ‘Jriple-click on the paragraph.

» To select a sentence and not just a line, hold down [Ctrl] and click once in any place within
the sentence.

« To select a vertical block of text, click at the start of the block. Later, hold down the [Shift] key
and click a second time at the opposite end of the block. This trick is used when only want to
copy one column of a tabular list

Approach (to find the difference in the shortcut)

These can be easily understood if you do it practically on MS word as it has very minute differences
which you need to see while performing and reading each point.
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Question 10 View this Question Online >

Which of the following is NOT a valid paragraph alignment in MS-Word?

1. Right

2. Top

3. Justify

A
G o

.

Answer (Detailed Solution Below)

Option 2 : Top

Microsoft Word Question 10 Detailed Solution

The correct answer is Top

The default alignment for the paragraph in MS-Word is Left.

The alignment buttons in the Home tab in the Paragraph section allows us to change
the alignment.

= Justified
It also provides the alignment for other objects such as picture, symbol, shapes etc.

& Additional Information

Font Formatting:

Ctrl+D opens the Font dia&&x for character formatting to format font type, style, size,
colour etc.

Ctrl+Shift+F moves directly to the Font type field in this dialogue box.

Ctrl+Shift+P moves directly to the Font size field in this dialogue box.

The keyboard commands for font styles are also the same as in previous Office versions:
Ctrl+B Bold style

Ctrl+1 Italic style

Ctrl+U Underline

Ctrl+1 Single line spacing

Ctrl+2 Double line spacing

Ctrl+5 1.5 line spacing
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Question 11 View this Question Online >
Which of the following best describes the MS-Word software?

1. Itis a firmware.
2. It is a word processor.
3. ltis a GUI-based operating system.

4. It is a system software.

)\

Answer (Detailed Solution Below)

Option 2 : It is a word processor.

Microsoft Word Question 11 Detailed Solution

The correct answer is It is a word processor

+ Sometimes called Winword, MS Word, or Word, Microsoft Word is a word
processor published by Microsoft. It is one of the office productivity applications included
in the Microsoft Office suite. Originally developed by Charles Simonyi and Richard Brodie,
it was first released in 1983.

+ Microsoft Word is available for Microsoft Windows, Apple macOS, Android, and Apple
i0S. It can also run on the Linux operating system using WINE.

« Microsoft Word allows you to create professional-quality documents, reports, letters, and
résumeés. Unlike a plain text editor, Microsoft Word has features including spell
check, grammar check, text and font formatting, HTML support, image support,
advanced page layout, and more.

+ Below is an overview of a Microsoft Word 2010 document.

[ O - ._t—.-\.rh.rn tab = §
g e I -l kel |
T =

e
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Application Software Type Examples

Word processing software | MS Word, WordPad, and Notepad|
Database software Oracle, MS Access, etc
Presentation Software Microsoft PowerPoint, Keynotes
Multimedia software Real Player, Media Flayer
Application Suites OpenOffice, Microsoft Office
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Question 12

2. TRl +F

3. CTRL+ R
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4, CTRL+ Y

Answer (Detailed Solution Below)
Option 2: CTRL + F

Microsoft Word Question 12 Detailed Solution

The correct answer is CTRL + F.

0 Key Points

+ In Microsoft Word, and othi@h word processors and text editors, Ctri+F opens a find box that
allows you to search for characters, text, and phrases in the current document. In Word
specifically, Ctrl+F opens a search box in the Navigation task pane.

+ In Microsoft Word and other word processors, pressing Ctrl+S saves the current
document.

+ In Microsoft Word and other word processors, pressing Ctrl+R right aligns a paragraph
or object in the current document.

« Control+R and C-r, Ctrl+R is a keyboard shortcut most often used to refresh the page in an
Internet browser.

« Control+Y and C-y, Ctri+Y is a keyboard shortcut most often used to redo an action
reversed using the undo command.
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Guestion 13 View this Question Online =

In MS-Word, if you want to display the meaning of a word in your text at the bottom of
the last page, which feature will help you?

1. Endnote

2. Footnote
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3. Bottomnote

4. Footernote

Answer (Detailed Solution Below)

Option 2 : Footnote

Microsoft Word Question 13 Detailed Solution

The answer is Footnote.

0 Key Points

k » Footnotes provide references to something in a document or give a message.
= Footnotes appear at the bottom of the page.
= It can be inserted using the “References” tab at the top of the word page.

A testbook

EW VIEW Tell me what you want to do

= sl

Header & Page
Footer MNumbers -

-

i Insert Endnote

Header & Footer Footnotes

« Other features:-
- Endnote:- They appear all together at the end of the text, instead of separately on each

page.
A testbook

VIEW Tell me what you want to do

D D AR | i Inserft kEndlrmt.eI

Header &  Page Insert
Footer MNumbers« Footnote

Header & Footer Footnotes

A\ Mistake Points

The guestion includes "Bottom of the last page”. To insert a note at bottom of the page, a footnote

LU S e (N . S [ T [ I T o I A TP T L 1 N (R T . |




B P Ui, L 1 vt TIctid U gl O FIVLE Qiticl LHIE LEAL M, LISl all Sl ial il 1 Watthl,

A testbook
N o
|1 - i -
...—'.
-—- ke
Footnote Endnote

endnote marker footnote marker

last page
1
i
4 separator
&  line
footnote — 1: : P
endnote —= i = -

NOTE: -

Footnote

In Microsoft Word, you would use the Footnote feature to display the meaning of a word at the
bottom of the page. This feature inserts a small superscript number in the text where you placed the
cursor, and you can type the definition (or any other note) at the bottom of the page, corresponding
to that number.

Just to clarify, while footnotes generally appear at the bottom of the page containing the
reference, an endnote appears at the end of a document or section. Neither "bottomnote” nor
“footernote” are features in Microsoft Word.

&
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Question 14 View this Question Online >

How many types of page orientation are available in MS-Word software ?

1. One
2. Two
3. Three

4. Five

Answer (Detalled Solution Below)

‘n 2 Two

Microsoft Word Question 14 Detailed Solution

The correct answer is " Two".

0 Key Points

Word offers two page orientation:

1) Landscape
2) Portrait.

« By default, when we open MS-Word or in the general case, the page is in portrait orientation
only. So, in this case, we have to change the page orientation to Landscape orientation.

« So, for performing this operation we will follow certain steps, in which instructions are given
with a diagram:

Steps to follow:
Step 1: First open MS-Word on your PC.

Step 2: Now, Open the document or create a new one in which you want to perform this operation.

Step 3: Now, go to the “Page Layout” tab.

File Home Insert §| Page Layout References Mailings Review View Add-Ins
Bcoors- [ - [==| Y= Breaks ~ = [ [ Indent
| 1 = BN )
| [A] Fonts - 4 Line Numbers ~ £F Left:. Oem
Themes Margins Orientation Size Columns _ Watermark Page Page -
. @ Effects = r * v . be” Hyphenation = - Color * Borders | E2 Right: 0 em
Themes Page Setup I Page Background |

Step 4: Now, In the Page Layout tab, go to the "Page Setup” section.

—
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Insert Page Layout References Mailings Revli

IER-RSEEE N

Margins Orientation Size Columns
- - v - b Hyphenation -

Page Setup _ Ia

Step 5: In Page Setup Section there is the option “Orientation”, Click on the Orientation button,
(shown in the image below) There are two options Portrait and Landscape. Select Landscape.

[

W

Insert Page Layout References Mailings Rewii
E E ¥= Breaks ~
| ;
: £3 Line Numbers -
Size  Columns W
r o = b~ Hyphenation =
Page Setup a

Step 6: So, the Page orientation is successfully changed to Portrait.
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Question 15

View this Question Online >

Which shortcut key is used to 'align center' the selected text in MS Word?

1. Ctrl + R

2. Ctrl +)

‘A

4. Cul + E

Answer (Detailed Solution Below)



Option 4 : Ctrl + E

Microsoft Word Question 15 Detailed Solution

The correct answer is Ctrl + E.

» The Microsoft Word shortcut keys make it easier to do everything from save your document
to undo a mistake.

« The shortcut key Ctrl + E is used to align the line or selected text to the centre of the screen.
« Microsoft Word is a word processor developed by Microsoft.
« It was released on October 25, 1983, under the name Multi-Tool Word for Xenix system.
« The commercial version of Word is licensed as a standalone product or as a component

of Microsoft Office or Windows RT.

« Ctrl + U is used to Underline the selected text.

"

Use

Shortcut
key

Aligns the line or selected texts to the
right of the screen.

Aligns the selected text or line to justify
Ctrl +)
the screen.

Ctrl + U Underline the selected text.

Ctrl + R




